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Abstract

The current marketplace for microscope incubators is primarily filled with high cost and large
devices that encapsulate the microscope. We created a low-cost cell culture incubator that can
maintain a specific internal environment while being compatible with an inverted microscope.
The internal environment must be 37 °C, greater than 95% humidity, and contain 5% CO2 within
the incubator. There are current designs on the market that meet this criterion, but these products
either include the inverted microscope integrated into the incubator, making it bulky and
inconvenient to disassemble, or the incubator is expensive. The team designed a cost-effective
cell culture incubator that would be portable and small enough to fit on the inverted microscope
stage, allowing the user to view live cells inside. The incubator included a heated water pump
and a CO2 pump in order to maintain viable cell conditions. Condensation, CO2 input regulation,
and live cell testing were conducted to find the optimal working environment for the incubator in
order to ensure cellular viability and visibility. Our device has succeeded in maintaining a
homogenous conditions of 37 °C, 95% humidity, and 5% CO2. However, we were unable to
prevent condensation from forming on the glass coverslide which resulted in compromised
microscope optics.

1. Introduction

Cell culture is a commonly practiced laboratory method for the use of studying cell
biology, replicating disease mechanisms, and investigating drug compounds [1]. Due to the use
of live cells during this process, incubators are necessary to keep the cells viable for the duration
of the study. Onstage incubators allow for live cell growth because they maintain a highly
regulated internal environment of 37℃, 5% CO2, and 95% humidity, without compromising the
viewing integrity of the microscope. The COVID-19 pandemic has caused the CO2 incubator
market to increase by 7.69% with an estimated market growth acceleration of 8% over the next
decade [2].
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Major disadvantages of current commercially available systems are that they tend to be
large and bulky, enclosing the entirety of the microscope making it difficult to assemble and
remove between uses while hindering the use of the microscope in general; they are also often
expensive; Fisher Scientific's Enviro-Genie cell incubator is priced at over $5,000 [3]. We aimed
to develop a low-cost cell culture incubator that allows for interchangeable culture plates,
compatibility with an inverted microscope, easy disinfection, and live cell imaging while
maintaining an internal environment appropriate for cell growth for approximately 10 hours.

1.1 Cell Cultures in Lab
Cell cultures are mainly used in the study of cell biology

due to their ability to easily manipulate genes, molecular
pathways, and culture systems to remove interfering genetic and
environmental variables [4]. Cell cultures follow BioSafety Level
2 guidelines, which describe the safety procedures for working in
a lab that can be associated with human diseases, and any
incubators being used in conjunction with cell cultures must
follow ISO Class 5 air quality standards [5], [6]. Cell cultures
have the ability to work with three different cell types: primary,
transformed, and self-renewing cells. Primary cells are directly
isolated from human tissue. Transformed cells are those that can
be generated naturally with changes to the genetic code, or
genetically manipulated. Self-renewing cells are cells that carry
the ability to differentiate into a variety of other cell types with
long-term maintenance in vitro. An example of self-renewing
cells is embryonic stem cells, whose isolation process is depicted
in Figure 1 [7].

Incubators used in cell cultures have to maintain a stable
microenvironment and can achieve this via regulated temperature,
humidity, CO2, O2, and pH levels. Controlling these factors is critical
for the viability and growth of the cultured cells, as the incubator aims
to replicate the cells' environmental conditions in the body (37℃ with
a pH of 7.2-7.4) [1]. CO2 is needed as a buffer to help with the pH
along with a culture medium. The medium most commonly used is a
Basal medium, with occasional serums added (such as fetal bovine
serum), which controls the physicochemical properties of the cell
cultures' pH and cellular osmotic pressure [8]. Many incubators are
therefore larger in size in order to maintain these homeostatic
conditions. One such example being the Thermo Fisher Heracell VIOS
160i incubator shown in Figure 2 [9]. However, there are some
commercially available stage top incubators that are able to adhere to
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the specifications required to keep cells viable, but they are often more expensive. Available
stage-top incubators include those from Okolabs and Elliot scientific, which have had great
success in maintaining a homogeneous temperature, humidity and CO2 environments [10], [11].
However, these incubators are expensive, require multiple assembly components, and encompass
the entirety of the microscope. This results in a steep learning curve and difficult usability for
inexperienced users.

1.2 Common Parameter Controls
There are two common methods to maintain the temperature in industrial cell incubators.

Many employ a method of direct heat, which tends to give off heat using electric metal coils that
surround the body of the incubator and are programmed to maintain the desired temperature. The
other common method is a water-jacketed incubator, which uses a controlled circulating water
bath cabinet around the body of the incubator to evenly heat the internal environment [9], [12].
Humidity control is most commonly achieved by placing a tray of water at the bottom of the
incubator. When the high temperatures of the incubator vaporize water from this bath, the
droplets have nowhere to escape, and a humid internal environment is established. This method
is used in both water-jacketed and direct heat incubators [13]. CO2 control is achieved through a
CO2 tank that automatically pumps the desired amount of gas into the incubator. Using tubes and
a valve connector, the CO2 tank is able to deliver gas to the inside of both water-jacketed and
direct heat incubators [9]. Many incubators also incorporate an automatic CO2 valve adjustment
system to maintain the proper internal environment when internal conditions are disturbed, such
as opening the incubator door to deliver more cell plates [9].

1.3 Clinical Significance
There is a significant need for live cells to be cultured via the assistance of an incubator.

Pharmaceutical companies often use these methods for drug development and testing because
live cell imaging can be utilized to screen chemicals, cosmetics, and other drug components for
their efficacy [1]. Live cell imaging is important because it allows for the observation of internal
structures and cellular processes in real time. This allows far more detailed insights into the
processes of cellular life to be made. Researchers can watch these processes in real time, or time
lapse, as opposed to viewing snapshots taken over a period of time. Pharmaceutical companies
can also assess the drug cytotoxicity in different cell types. Virology and vaccine products
benefit from live cell cultures, as they can be used to study viruses in order to make new
vaccines, such as in the product of the SARS-COVID-19 vaccine [1]. Embryonic stem cells are
widely studied for their regeneration properties due to genetic engineering/gene therapy
applications of these cell cultures, and the expression of specific genes and the impact they have
on other cells can be studied [7].
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2. Previous Work

2.1 Temperature and Humidity
Through previous work, the thermistor was compared against a DHT22 temperature and

humidity sensor to ensure its accuracy [14]. It then underwent a Temperature and Humidity
Sensor Protocol which is further expanded upon in Appendix C. The temperature readings for
both the thermistor and ECB 1002 Lab Incubator were recorded every 10 seconds for a total of
10 minutes. Next, a two-sample t-Test assuming equal variances was performed to determine the
statistical significance between the data obtained from the thermistor as compared to the standard
incubator. The results in Figure 4 showed a p-value of 0.406 with a significance value of 0.05,
indicating that there is no statistical significance between the thermistor temperature readings
and the incubator temperature, proving that the thermistor is working properly. It is worth noting
the axes in Figure 3, as though it appears there is significant variation between the thermistor and
incubator temperatures, all these variations were within 1℃.

Figure 3: Thermistor Temperature over 10 minute Interval in Lab Incubator to compare the
accuracy of the Thermistor and the Incubator Temperature Values

A thermistor was used to measure the internal temperature of the incubator and was
coded to also determine the relative humidity. Relative humidity was calculated using Equation 1
[15].

https://www.zotero.org/google-docs/?nnopif
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RH = relative humidity e = actual vapor pressure es = standard vapor pressure
Tc = Temperature (℃)

Humidity data was collected for ten minutes using both the thermistor and the DHT22
sensor, and a two-sample t-Test assuming equal variances with a significant value of 0.05 was
performed to determine the statistical significance between the two collections. The results
showed a p-value of 0.9437, indicating that there was no statistical significance between the two
sensors, proving that the humidity formula is working accurately, see Figure 4. The Temperature
and Humidity Sensor Test Protocol was also passed when the thermistor was placed inside the
incubator, validating that the formula provided for the sensor is reliable and accurate.

Figure 4: Humidity Readings in Incubator Over 10 minute Time Interval comparing the values
from the Standard Incubator and the Sensor’s output based on Equation 1.

The results from previous experiments allowed us to use the thermistor for temperature
and humidity readings within our device.



2.2 Anti-Fog/Condensation Prevention
Previous semester work for anti-condensation included the wiper blade design which was

determined to be too mechanically challenging to move forward with. The wiper blade also did
not allow the client to perform time lapse imaging due to the need for manual intervention. The
team also conducted anti-condensation testing with an anti-condensation spray [16]. The
anti-condensation spray was applied to the top lid glass in different amounts, buffered, and then
tested to determine the effectiveness. After testing, the anti-condensation spray was deemed
ineffective and was not further pursued.

3. Methods

The team aimed to create an incubator with an internal environment of 37℃ ± 1 °C, 5%
± 1% CO2, and 95-100% humidity with homogeneous heating and humidity across the chamber.
The incubator must also be compatible and easy to operate on an inverted microscope stand
(roughly 310 mm × 300 mm × 45 mm) and have the ability to fit a standard well plate inside
(127.55 mm × 85.4 mm × 22.5 mm). See Fall 2022 Final Report for incubator materials and
fabrication information.

3.1 CO2 Control
The CO2 was measured using a MH-Z16 NDIR sensor (part number SEN-000030) from

Sandbox Electronics, which is water/humidity resistant, and able to read the concentration of
CO2 in ppm [17]. Since ppm can actually be interpreted as 1/1,000,000 or 0.0001%, the ppm
value read from the sensor can be converted into a percentage of the internal environment by
dividing the ppm value by 10,000. A gas permeable RKI Sensor Cover (part number
33-0172RK) from RKI, was utilized to make the MH-Z16 fully water-proof while inside the
humid incubator environment [18]. See Appendix E for further sensor and cover specifications.

The sensor is also compatible with an Arduino microcontroller [17]. The input of CO2

into the incubator was controlled using a relay circuit system and a solenoid valve [19], [20]. See
Figure 3 for further system specifics. A 100% CO2 tank was used as the system CO2 input due to
its availability and low-cost [21]. The relay circuit system, in tandem with the solenoid valve,
used a negative feedback loop to allow only 5% of the incubator’s internal environment to be
CO2 input at any given time. This can be further visualized using the block diagram in Figure 5.

https://www.zotero.org/google-docs/?hgZYcN
https://bmedesign.engr.wisc.edu/projects/f22/scope_incubator/file/view/11e690e4-69da-4902-baed-0a4a623d2a5b/Final%20Report%20Fall%202022.pdf
https://www.zotero.org/google-docs/?8wHg5A
https://www.zotero.org/google-docs/?xP5991
https://www.zotero.org/google-docs/?4mgpq9
https://www.zotero.org/google-docs/?PoVu1x
https://www.zotero.org/google-docs/?XzI0ZV


Figure 5: Circuit Block Diagram in which the recorded values from the Thermistor (temperature
and humidity) and CO2 sensor are sent to the Arduino which regulates the opening/closing of the

solenoid valve via a beefcake relay.

This figure focuses on the communication between the NDIR MH-Z16 sensor and the
solenoid valve to regulate the volume of CO2 in the incubator. The goal for the interior of the
incubator was to maintain a homogeneous 5% CO2 environment at all times in order to maintain
an internal pH of 7.0-7.4. Cells are very sensitive to changes in pH and a neutral pH is required
for healthy cell growth. In an environment that is too acidic, the cell membrane can be damaged
and cellular processes are disrupted, whereas a basic environment can alter the structure of
proteins and other biomolecules [8].

3.2 Anti-Fog/Anti-Condensation
Since the previous semester anti-condensation testing methods were not successful, other

methods were considered. The first method was applying thin copper tape in an arrangement
similar to a rear view car window defroster shown in Figure 6 [22]. Various voltages could be
sent through the copper tape, with the idea that the copper would heat the glass up to above 37
degrees celsius, preventing the formation of condensation onto the glass.

https://www.zotero.org/google-docs/?ZlbKKc
https://www.zotero.org/google-docs/?Ob6rSc


Figure 6: Anti-condensation copper tape arrangement for the top lid glass.

The team also considered using a mini-fan alternative, so two Coolerguy mini-fans, 25
mm × 25 mm × 10 mm part number 840556070320, were purchased [23]. These mini fans have
a USB power supply cord that can be connected to a USB wall charger. The fans are small
enough to fit inside of the inner box in the incubator and require no fabrication. Once the fans are
plugged in, they produce a small amount of air movement, with the intent to help prevent or
remove condensation on the glass lid.

The next anti-condensation idea was to use a 1:1 ratio of anti-bacterial hand sanitizer and
water. A research study compared the use of antibacterial hand sanitizer, iodophor, and water to
prevent fog formation in goggles among 90 healthcare workers, with the hand sanitizer having
the best results [24]. The team tried following similar methods to reduce anti-condensation
among the incubator lid glass. The hand sanitizer was mixed with water and then applied to the
incubator lid glass with a cotton ball to ensure an even coating and then air dried.

Lastly, polydimethylsiloxane (PDMS) was considered to be used for anti-condensation.
Since PDMS has extremely hydrophobic properties, the idea of having a thin layer placed onto
the lid glass would help prevent the formation of condensation. The layer of PDMS would be
thin enough to not alter imaging optics. The PDMS idea was also partnered with the mini-fans
with the intent to help blow the condensation droplets on the hydrophobic surface away from the
viewing area.

3.3 Cell Viability
Cell viability was tested by comparing cell proliferation of mice osteoblast cells in a

standard control incubator and in the prototype. Using two T25 flasks each starting with
approximately 200,000 cells each, one was cultured for four days in the standard incubator and
the other was cultured for four days in the prototype incubator. Cells were passaged using 25%
trypsin to remove them from the previous flask, prior to centrifugation and implantation into a
new T25 flask. 5 mL of fresh basal media was added to each flask at the start of the test and it
was not changed during the duration of the test. Every 24 hours each flask was imaged using the
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Zeiss microscope at 5x magnification. Each image was analyzed using ImageJ to quantify the
percent area covered by the cells. The data was compared using a two sample t-test with a
significance value of .05 to determine if the cellular growth within the data sets were statistically
different.

4. Testing

4.1 Anti-Fog/Anti-Condensation
Anti-condensation testing was performed with the copper tape arrangement on an extra

piece of glass by building a simple circuit with a 3.3 V, 5 V, and 12 V power supply. Once the
circuit was closed, the glass was placed above a beaker on a hot plate, creating a humid
environment. Condensation prevention was noted for the different voltage values.

Anti-fog mini-fan testing was performed by placing two mini-fans inside the incubator
and then taking images at consistent intervals for approximately an hour. Further testing
specifications can be seen in the Fan Testing Protocol and Optical Image Analysis Protocol
sections of Appendix C: Testing Protocols. Different orientations of the two mini-fans were
tested under identical conditions to determine the best arrangement of each mini fan. This is due
to the fact that one singular fan did not produce enough air movement to sufficiently reduce
condensation on the glass. At the 45 minute marker, the incubator lid was removed for 30
seconds and then placed back on to the incubator box. The lid was open and closed to determine
how the mini-fans would respond to an internal environment disruption. In each image, the
percentage of condensation buildup was calculated by dividing the total condensation buildup
area by the total glass area and multiplying it by 100. The images were analyzed with ImageJ.
The first test was completed by placing the fans on opposite corners of the incubator and in the
second test, the fans were placed on adjacent corners of the incubator. In both orientations the
mini fans were angled upwards at approximately 45 degrees to maximize the airflow onto the
glass lid as seen in Figures 7 and 8.

Figure 7: Photo showing the opposite corner dual mini fan setup where the fans are
angled up at roughly 45 degrees



Figure 8: Photo showing the same side dual mini fan set up where the fans are angled up
at roughly 45 degrees

Antibacterial hand sanitizer anti-fog testing was performed using the same methods and
protocols as the mini-fan testing. Condensation build up was recorded after an hour of testing at
various time intervals, as well as after opening and closing the lid.

Lastly, PDMS anti-condensation testing was performed by placing a small rectangular
strip of PDMS with and without a mini-fan onto an incubator lid glass (See Figure 9). The lid
was then placed over a beaker on a hotplate, replicating the humid incubator environment.
Condensation values were recorded over an hour-long period.

Figure 9: PDMS anti-condensation testing setup with and without a mini-fan



4.2 CO2

4.2.1 Accuracy Testing:
The CO2 MH-Z16 sensor was initially tested for accuracy via placement into the Standard

Incubator in ECB 1002. The test was performed in accordance with CO2 Sensor and Feedback
System Test Protocol. The MH-Z16 Sensor was placed in the standard incubator and recorded
the percent CO2 over the course of 10 minutes.

4.2.2 CO2 Feedback Loop:
Next the CO2 feedback loop between the MH-Z16 sensor and the solenoid valve circuitry

was tested in accordance with Internal Environment-CO2 Sensor and Feedback System Test
Protocol. The entire CO2 system was set up and tested with an empty incubator (no water bath or
temperature/humidity) to test how the feedback loop would regulate the release of CO2 from the
system. The test was run for approximately an hour and 20 minutes collecting data on the percent
CO2 in the incubator. The lid of the incubator was also opened twice during the testing to
determine how the system recovered from interruption.

4.2.3 CO2 Testing with Temperature and Humidity:
To ensure that the MH-Z16 sensor and feedback loop were working properly with all

elements of the incubator and to ensure there were no issues after a long amount of time. The
incubator was set up for proper use, electronics and water bath, with the exception of
incorporating live-cells. The temperature and CO2 values were recorded over a 9-hour period,
humidity was not recorded as the condensation on the top surface ensured that humidity was
present in the system.

4.3 Cell Health

4.3.1 Cell Proliferation:
To ensure the prototype could maintain cellular viability using the Cell Confluency Test

Protocol. A T25 flask of cells were placed into the prototype and cultured for 4 days to track
cellular proliferation. At passage 17, 20k cells were seeded into two separate flasks. Using the
Zeiss Microscope, a 5x image was taken of the cells every 24 hours. The images were analyzed
in ImageJ to measure the percent area covered by the cells, see the ImageJ Percent Area
Coverage Protocol. The growth curve was then compared to that of the standard incubator.

4.3.2 pH Testing:
To ensure a neutral pH of 7 was being maintained in the culture media in the prototype,

during the cell proliferation test, the pH was also measured. When the T25 flask was removed
from the prototype to be imaged, 100 µL of media was removed via pipette and placed on
Hydrion pH paper [25]. After approximately 30 seconds, the pH paper turned color and the pH

https://www.zotero.org/google-docs/?Kxnplb


was able to be determined using the color guide provided with the Hydrion paper, pink being
very acidic (pH=0) and blue being very basic (pH=13).

5. Results

5.1 Anti-Fog/Anti-Condensation
Anti-condensation testing for the copper tape design was discontinued after calculations

showed that 10-20 Amps of current were needed in addition to a 12 V power supply to obtain the
needed temperatures to prevent condensation accumulation. The calculated voltage and
amperage were too high to achieve and posed safety issues.

Figures 10 and 11 show the results from the anti-fog/anti-condensation testing in the
different fan orientations. When the two fans were located on opposite corners of the incubators,
a maximum condensation area of 17% was seen before lid removal, and then increased to 51%
after the internal environment disruption. The glass fogged up in the middle (See Figure 12),
where the incubator light needs the most transparency to provide clear images, resulting in the
failure of this arrangement. The same-side dual mini fan setup had similar results. After 45
minutes of testing, the percent condensation was about 50% and after the internal environment
disruption, the percent coverage of fog was about 52% see Figure 13. This was also deemed to
be nonsignificant for optical clarity and was discontinued.

Figure 10: Graph of Fog Percentage Over 75 min Time Interval with Fans on Opposite Corners.
At t=45 minutes, the lid was open and closed to test recovery efficiency of the fans.



Figure 11: Graph of Fog Percentage Over 45 min Time Interval with Fans on Adjacent Corners.
At t=45 minutes, the lid was open and closed to test recovery efficiency of the fans.

Figure 12: Image of the fog build up for the diagonal dual mini-fan placement 15 minutes after
the lid was open and closed for 30 seconds.



Figure 13: Image of the fog build up for the same side dual mini-fan placement after 45 minutes

The anti-bacterial condensation prevention idea was also discontinued after the results
showed visibly minimal condensation prevention in as little as 20 minutes (See Figure 14).

Figure 14: Anti-bacterial hand sanitizer condensation prevention results after 20 minutes



Lastly, the PDMS anti-condensation testing idea was also discontinued after visibly
minimal condensation prevention after 30 minutes for both the PDMS with and without a fan
(See Figure 15). Despite the hydrophobicity of PDMS=, significant condensation droplets still
formed on its surface.

Figure 15: PDMS strip anti-condensation prevention testing after 30 minutes with and without a
mini-fan

5.2 CO2 Results

5.2.1 Accuracy Testing:
The results from the accuracy testing showed that the MH-Z16 sensor was able to

accurately record the amount of CO2 in the standard incubator, as seen in Figure 16, see
Appendix D for code. A two-sample t-test was performed assuming equal variances comparing
the data from the MH-Z16 sensor and the Standard incubator values. The p-value from this test
was 0.12 indicating that our results were not statistically significant.

Figure 16: MH-Z16 vs Incubator Readings over a 10 minute period to ensure initial accuracy of
CO2 values from the MH-ZI6 CO2 sensor and the incubator output.



5.2.2 CO2 Feedback Loop Results:
The results from the testing showed that the feedback loop was effective in regulating the

amount of CO2 in the incubator, see Figure 17 and Appendix D.3 for code. The average humidity
in the incubator was 4.96%, which is within the standard of 5% ± 1%. The 1st lid opening
occurred around the 40 minute mark and showed that the incubator was able to self-regulate
within 5 minutes. The 2nd lid opening was not marked due to brevity, however it’s shown by the
3 outlier points around the 61 minute mark.

Figure 17: Results of CO2 Over Time during Initial Feedback Loop Testing. Understanding how
the MH-Z16 NDIR CO2 sensor communicates with the Arduino which tells the beefcake relay to

turn on the solenoid valve to control the flow of 100% CO2 into the incubator.

5.2.3 CO2 with Temperature and Humidity:
The results over the 9 hour period showed that temperature and CO2 were within

specifications, 37°C± 1° C and 5%± 1%, with an average temperature of 37.9℃ and average
CO2 of 4.97% as seen in Figure 18. Humidity was not recorded due to obvious humidity on the
glass proving that it was greater than 95%. The results were not statistically significant as
compared to the standard incubator as the p-value for temperature was 0.39 and the p-value for
CO2 was 0.20, see Appendix D.4 for code. The test also revealed that the feedback loop was
working properly as approximately every 15 minutes the %CO2 would fall to 4.5% and the
system would immediately self regulate itself.



Figure 18: CO2 and Temperature Over 9-hour Period showing accuracy in both temperature and
CO2 and the autoregulation system.

5.3 Cell Viability Results

5.3.1 Round 1
The first round of live cell testing showed flaws within the design. The incubator was set

up for proper use and 20k cells were seeded into a T25 flask which was placed into the prototype
incubator. An identical flask was placed into the standard incubator to provide a control group
for comparison. The incubator ran for four days with the internal temperature, humidity, and CO2

being collected every 10 minutes, and the cells were imaged every 24 hours. The incubator was
set up on one of the microscopes in the teaching lab. This quickly became a problem despite
having numerous signs asking others to not disturb the experiment. Members of the team found
various electronic aspects unplugged at certain points and the CO2 tube was even removed from
the incubator between days three and four leading to acute cell death, as seen in Figure 19. After
16 hours of testing, the CO2 sensor also appeared to be giving communication error signals every
30 minutes and needed to be restarted leading to a loss of CO2 in the incubator. This was
theorized to be due to a build-up of humidity/water residue in the sensor. The heated water pump
was also placed on the ground, to condense the area of space used in the lab. This proved to be
inconvenient as the necessary temperature was not reached, see Figure 19. The team attributed
this to gravity affecting the strength/circulation of the water and also it caused the copper tubing
to be raised from the water bath not allowing the water bath to reach the proper temperature
needed. The lack of proper temperature in the incubator also contributed to a loss of proper



humidity conditions as seen in Figure 19. While pH wasn’t measured during this test, the culture
media was a dark pink color which indicates that it was a basic environment which also
contributed to the cell death. Figure 20A-B shows how the cells should proliferate over 70 hours
when in a stable and healthy environment (the standard incubator). Whereas Figure 21A-B
shows how the cells died when placed in an unstable environment. The cells appeared healthy
and were proliferating during the first 40 hours of testing but then experienced a decline in cell
coverage, indicating cell death as seen in Figure 22. The results of the first round of testing
proved that the team needed to re-evaluate the set up of the incubator.

Figure 19: Live Cell Testing Trial 1一 Averages of each condition over the course of 4
days worth of testing.

Figure 20: A: (Left) Cell coverage of control flask at 24 hours. B: (Right) Cell coverage
of control flask at 70 hours.



Figure 21: A: (Left) Cell coverage of prototype flask at 24 hours. B: (Right) Cell
coverage of prototype flask at 70 hours.

Figure 22: Comparison of cellular proliferation between cells cultured in the control
incubator vs. cells cultured in the prototype incubator.

5.3.2 Round 2
Due to the results of the first round of testing, the team revised the original plan. The

heated water pump was placed on the table so gravity would not affect the circulation of heat
throughout the incubator. The CO2 also had a water-proof gas permeable cover placed around it.
This was an attempt to prevent the sensor from outputting sensor communication errors that
interfered with the communication between the solenoid valve. The CO2 sensor was tested with
the cover to ensure that the measurements were accurate before round two testing occurred. The
testing environment was also changed as more signs were added to the surrounding elements
urging onlookers not to disturb the experiment. The incubator itself was also covered with the
microscope cover to ensure that it was not disturbed. All plugs needed were also taped into
outlets with adjourning signs that urged not to unplug. The incubator was set up for proper use



and 20k cells were seeded into a T25 flask which was placed into the prototype incubator and
another identical flask was made and placed in the standard incubator. The incubator was run for
approximately four days with the internal temperature, humidity, and CO2 being collected every
10 minutes, and the cells were imaged every 24 hours. The results of this experiment indicate
that the cells died due to sensor communication errors causing a lack of CO2 input during hours
10-20 of the experiment, seen in Figure 23. The average temperature and humidity values were
within the specified range, 37.38℃ and 97.21%, while the average CO2 over the course of
testing was not, with a value of 4.36%. The pH of the experimental flask was also compared with
the control flask showing that the experimental flask had a pH of approximately 10 as compared
to the control flask’s pH of 7. The dark pink color of the prototype media also indicated that the
pH would be very basic whereas the pale pink color of the control media indicated a more
neutral pH. This cemented the assumption that the lack of CO2 caused cell death because the CO2

regulates the pH of the culture media. Again, Figure 24A-B shows how the cells should
proliferate while in a stable and optimal environment. Whereas, Figure 25A-B shows how the
cells died off over the course of 90 hours due to the basic conditions of the environment. Figure
26 shows that after 20 hours the cells started to die off as seen in the decrease of cell coverage.
The next steps after this experiment were to refigure the code to eliminate sensor communication
errors and to input CO2 for a longer period of time.

Figure 23: Internal Conditions graphed on log scale showing that CO2 was under accepted
value.



Figure 24: A: (Left) Cell coverage of control flask at 24 hours. B: (Right) Cell coverage of
control flask at 90 hours.

Figure 25: A: (Left) Cell coverage of prototype flask at 24 hours. B: (Right) Cell coverage of
prototype flask at 90 hours.

Figure 26: Comparison of cellular proliferation between cells cultured in the control incubator
vs. cells cultured in the prototype incubator.



5.3.3 Round 3/pH Test
The team measured the pH of the flask and determined that the CO2 input was the

problem in the previous experiments. To address this, four flasks of cells (1 control flask (C) and
3 testing flasks (T1, T2, T3)) were separated, where three corresponding experiments were
conducted (See Table 1 for results). We first tripled the amount of CO2 in the incubator by
increasing the release time from the code found in Appendix D, and placed one test flask (T1) in
the incubator for approximately 30 hours. The other 3 flasks remained in the standard incubator.
The temperature, humidity, and CO2 were recorded every 3 minutes with CO2 being the greatest
interest. At the start of the test, images were taken of flasks C and T1. The code was
reconfigured to input CO2 whenever sensor communication errors occurred. After 30 hours, flaks
C and T1 were removed from the incubators, where the pH was taken and were inspected via the
Zeiss microscope. The tripled amount of CO2 led to a pH of approximately 5, see Figure 27, with
an average CO2 of 10%, leading to unhealthy conditions for the cells. T1 was thrown away and C
was placed back into the control incubator. The amount of CO2 was doubled and then flask T2
was placed inside the incubator for approximately 30 hours. After 30 hours, C and T2 were
removed from their incubators, where their pH was taken and were inspected via the Zeiss
microscope. The amount of CO2 recorded was 6.5% and the pH was approximately 6, see Figure
28. T2’s cells were also in an unhealthy state, therefore the flask was discarded and flask C was
placed back into the standard incubator. We concluded that the CO2 may be inputting too much
CO2 when frequent sensor communication errors arose. The code was changed again to input
approximately 1.5 times the original amount of CO2, with no CO2 inputted during sensor
communication error signaling. T3 was then placed into the prototype incubator. Within the first
24 hours, we concluded that the pH was slightly too basic at a pH of approximately 8 with the
average CO2 being 3%, see Figure 29. The CO2 was increased to 1.75 times the original amount
and CO2 was inputted during sensor communication errors. This flask was left for approximately
2 days. On day 1, the flask changed color to a light yellow and the pH reached approximately 7,
see Figure 30. However, on day 2 the flask changed color again to a light purple color, indicating
a pH greater than 7. The sensor began to malfunction after the second day of testing resulting in
a value of 0% CO2 in the box. T3’s cells were also in an unhealthy state due to the fluctuations in
pH and CO2 input and discarded.



Table 1: pH Testing Results for Cell Proliferation

CO2 release time change
from original amount (50ms)

pH Average %CO2

3x 5 10%

2x 6 6.5%

1.5x 8 3%

1.75x 7-9 Sensor Failure

Figure 27: pH strips of control vs prototype at 3x the amount of CO2 showing that the control
had a pH of approximately 7 while the prototype had a pH of approximately 5. The yellow

discoloration in the prototype flask indicates oversaturation of CO2.



Figure 28: 2x the amount of CO2 released. A: (Left) shows the control group in which the pH is
approximately 7 and the color is a light pink. B: (Right) shows the prototype group in which the

pH is approximately 6 and the color is orange.

Figure 29: 1.5x CO2 released comparing the control to the prototype. The control is an orange
color with a pH of approximately 7, while the prototype is purple with a pH of approximately 8.



Figure 30: 1.75x CO2 released comparing the control to the prototype. Both have around the
same coloration and a pH of approximately 7.

6. Future Work

In the future, a protoboard should be fabricated to improve the professional look of the
device. The team should also consider the financial implications of using a variety of sensors and
devices (mini-fan, display case, etc) that were gifted to the team. The team may need to change
the types of materials used in order to fabricate a device that is under $100 in raw material costs,
or increase budget to reflect these donations.

Condensation prevention is another major area of future work for the team. Although
multiple condensation prevention methods were attempted this semester, the mini-fan method
showed the most promise, even though it did not work well enough. The team would either need
to pursue a way to make the mini-fans more powerful or find a new anti-condensation method



altogether. One potential solution could be to explore alternative methods of heat generation for
the incubator glass instead of relying solely on electrical current.

A new CO2 sensor should be purchased that has the capability to record values in extreme
condensation/humidity conditions. The failure of the NDIR sensor over time led to a decrease in
the amount of CO2 being pumped into the incubator due to the failure of the feedback loop being
more frequent. A neutral pH was reached with the CO2 at 1.75 times the original milliseconds
(ms) value (87.5 ms) with the original ms value (50 ms) being pumped in during sensor
communication errors. In the future, with a different more viable sensor, this approach should be
further researched to determine its true efficacy in terms of pH and cell proliferation over time.

To avoid the problem of sensor errors and condensation, a direct heat approach may be
beneficial to switch to. Direct heat allows for a dry environment that allows for temperature and
CO2 to be within range. However, this approach would need some way for humidity to
proliferate in order to mimic the cells internal environment. Future research is needed to
determine if this is a more viable solution than attempting to waterproof CO2 sensors.

7. Discussion

In terms of anti-fog testing, the results of every test showed that there is no one best
solution to prevent the formation of condensation on the incubator lid glass. Some possible
sources of error between anti-condensation testing could be due to using a hot plate and beaker to
test feasibility instead of using the actual incubator for each test. Another error could be not
including the flask while doing the anti-condensation testing, which could disrupt airflow of the
mini-fans, changing results dramatically.

In terms of the internal environment, temperature and humidity were easily achieved via
a water bath and heated water pump. Both values were continuously in range after live cell round
2 testing. However, the NDIR CO2 sensor continuously got worse in terms of reading the value
of CO2 after exposure to the incubator for a long period of time. It was initially able to withstand
approximately 10 hours of exposure, but quickly the amount of condensation/humidity within the
environment overpowered the sensor and it began to fail more frequently. The failure of the CO2

sensor led to a failure of the feedback loop to pump in the correct amount of CO2 needed to keep
a neutral pH. The pH was consistently too acidic or too basic depending on the amount of time
the feedback loop was instructed to pump out CO2. The NDIR sensor was not equipped to
survive within these conditions and ultimately accelerated cell death.

In terms of maintaining cell viability, the device unfortunately failed. The pH was unable
to be maintained at a neutral 7 which caused the cells to slowly die off either due to cell
membrane damage or altered protein structures. At most, the device could maintain cell viability
for 24 hours, but any time after that the cells reacted negatively by stopping proliferation and
condensing in on themselves. If the CO2 input would have been adequate to maintain a pH of 7,
then the cells would have likely survived and proliferated making the device successful.

Sources of error in the measurement of cell proliferation may include imaging a different
area of the flask every day and some dead cells were included in images. The implications of



these sources of error are that the number of cells may be slightly different than the true value.
Other sources of error include the numerous sensor communication error signals that were
outputted during testing. These did not allow the team to determine the true value of CO2 in the
incubator.

Ethical considerations need to be taken into account as this device will be used in a live
cell lab. The origin of the cells being studied was of the utmost importance. The client plans to
use immortalized pre-osteoblasts isolated from the calvaria of newborn mice. The use of animal
cells has caused much ethical controversy over the past half-century. Mice are commonly used in
laboratory research as their entire genome has been sequenced and compared to the human
genome and they are easily bred and housed [26]. Extra measures must be taken to ensure that
the newborn mice are subject to the least amount of harm, distress, and pain in order to conduct
an ethical experiment. The Animal Welfare Act, a federal law that outlines the standard of care
animals must receive in laboratories, is also a necessary requirement of labs to follow when
using mice, and other AWA-approved animals, with the incubator [27]. If in the future, human
cells are used, the consent of the subject must be granted before cells are placed in the incubator.
Ethical consideration must also be given if the cells are to be manipulated in the future, rather
than just watching the growth of the cell. Gene editing has become quite the controversy over the
past 20 years, with the ethical considerations of its use in treating cancer, preventing
life-threatening diseases in gestation, and its use in what has been termed “designer babies” the
idea that one can alter the DNA in a prenatal cell to fit the desired phenotype or genotype of the
parents. Designer babies are currently legal in Sweden, Spain, Belgium, the UK, and the US [28].
Furthermore, ethical considerations must be made when determining how manipulations of the
cell will alter not only the DNA but evolution as a whole. The societal implications of prescribed
DNA mutations must also be taken into account as the effects of this process can range from the
elimination of genetic diseases to the elimination of certain phenotypes altogether.

8. Conclusion

The client envisioned a cell culture incubator for semesterly use in a teaching lab that
would be lightweight and compact, compatible with an inverted microscope, able to maintain a
stable internal environment, and cost-effective. The team proposed a design that meets all these
criteria. The proposed final design included a copper tube that was wrapped around the inside of
the incubator and connected to a heated water pump that regulated the internal incubator
conditions. The lid to the incubator was placed on top which allowed for a tight seal of the
internal environment and helped prevent leakage. The incubator box also contained holes for
CO2 input, a CO2 sensor, and a thermistor temperature sensor that will in addition be coded to
calculate the internal humidity. The CO2 input was monitored using a solenoid valve that
received direction from a NDIR sensor in communication with an Arduino microcontroller. The
team conducted testing to mitigate condensation buildup, measure cell viability, and determine if
the internal homogenous environment could be maintained. While the prototype was able to
maintain a homogenous internal environment for extended periods of time, unfortunately,

https://www.zotero.org/google-docs/?o3xHg9
https://www.zotero.org/google-docs/?WEVwcJ
https://www.zotero.org/google-docs/?TtCbHV


condensation and cell viability issues persisted. Moving forward, the team would work to obtain
either a new CO2 or pH sensor, continue live cell testing to evaluate cell viability, and experiment
with anti-fog and anti-condensation methodologies.
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Appendices

Appendix A: Product Design Specifications (PDS)
Function: Develop a low cost cell culture incubation chamber that is compatible with an
inverted microscope and capable of live cell imaging over the course of one week.

Client requirements:
● Incubation chamber must be able to maintain an internal environment of 37℃, 5% CO2,

and 95-100% humidity
● Microscope’s optics and functionality must not be damaged
● Maintain even heating and humidity across the chamber
● Create device that stays within a budget of $100
● Ensure that the device can be easily assembled and removed between uses

Design requirements:
1. Physical and Operational Characteristics

a. Performance requirements: The device must be able to sit on a microscope stand
(less than 310 x 300 x 45mm[1]), be transparent on the top and bottom to allow
for optical visualization with an inverted microscope, and maintain an internal
environment of 37℃, 5% CO2, and 95-100% humidity. This device should
demonstrate no quantitative difference on the microscope when adding glass
compared with solely cells, in order to demonstrate full transparency of the top
and bottom slides of the system.

b. Safety: The incubator and the cell culture environment must be in cooperation
with BioSafety Level 1 Standards [2]. Any material and electrical or mechanical
machinery must be sterilizable and waterproof.

c. Accuracy and Reliability: The device must be able to maintain a temperature of
37°C ± 1°C throughout the entire internal environment. The humidity must be
kept above 95% humidity. CO2 levels must be 5% ± 1%. The incubator must be
able to maintain these conditions constantly for at least two weeks. The device
must also be able to reach these conditions after the incubator has been opened
and exposed to the external environment within five minutes of interruption.

d. Life in Service: The device must be able to be used for two weeks, but optimal
usage will occur for one week at a time for teaching purposes in the client’s tissue
lab (including cell viability for one week as well).

e. Shelf Life: The shelf life of this product should be 10 years.
f. Operating Environment: The operating environment is a clean room. The

incubation chamber must be able to maintain an internal environment of 37°C,
5% CO2, and 95-100% humidity for at least two weeks, without compromising
the integrity of the microscope’s optics or functionality. Measures must be taken
to ensure that the temperature is the same in all areas of the chamber with an error



of ± 1° C. The box also must be sealed efficiently to ensure that evaporation does
not occur.

g. Ergonomics: The device should be portable in that one should be able to carry
and store the device easily. Wires should not be hanging freely out of the device,
and it should be easy to pick up and put away when needed.

h. Size: The device must be less than 310x300x45mm in order to fit on the
microscope stand without interfering with the optics[1].The bottom and top of the
incubator will be transparent. Overall, the product must be compatible with an
inverted microscope.

i. Weight: There are no specific weight requirements. However, minimizing weight
would be ideal to promote incubator transportability and usability.

j. Materials: There are no specific materials that are required for development of
this device. However, it is important to examine different material properties to
determine which materials hold heat effectively, are water tight, and have a
transparent appearance.

k. Aesthetics, Appearance, and Finish: The client does not have a preference in
color. Well plates are clear, black (to stop contamination), and white (to increase
light). Using materials that would block out external light sources would be ideal,
but this is not a requirement for the device. Finish should exclude messy
elements, such as long wires, and be transparent on both the top and bottom.

2. Production Characteristics:
a. Quantity: Only one device is necessary to produce, but ideally, it would have the

capacity to be produced on a larger scale to be used repeatedly in the teaching
labs.

b. Target Product Cost: The target product cost for this device is $100. It will be
financed via UW BME Departmental teaching funds.

3. Miscellaneous
a. Standards and Specifications: The incubator would need to adhere to the ISO

13485 regulation which outlines requirements for regulatory purposes of Medical
Devices [3]. The incubator would also need to follow the FDA’s Code of Federal
Regulations Title 21, Volume 8 where it outlines the requirements for Cell and
Tissue Culture products [4].

b. Customer: The client, Dr. John Puccinelli, is an undergraduate advisor in the
Biomedical Engineering Department at the University of Wisconsin - Madison.
Dr. Puccinelli is asking for the cell culture incubator in order to amplify the
teaching curriculum in his classroom environment. Having an incubator that is
easy to disassemble and compatible with an inverted microscope would result in
efficient classroom lessons.

https://www.iso.org/standard/59752.html
https://www.iso.org/standard/59752.html
https://www.accessdata.fda.gov/scripts/cdrh/cfdocs/cfcfr/cfrsearch.cfm?fr=864.2240
https://www.accessdata.fda.gov/scripts/cdrh/cfdocs/cfcfr/cfrsearch.cfm?fr=864.2240


c. Patient-related concerns: The accuracy of the temperature, humidity, and CO2

concentration is of utmost concern for the client. Humidity must be 95-100%,
otherwise cells will begin to dry out. Having a set temperature of 37°C will
replicate optimal cellular environments. Lastly, ease of disassembly and
disinfecting of the incubator was of concern.

d. Competition: There are currently multiple inverted microscopes and cell culture
incubators on the market ranging from $500-$40,000 [4]. Thermo Fisher, NuAire,
and New Brunswick all have incubators currently on the market. Thermo Fisher
and NuAire are more popular as they have both direct heat and water jacketed
incubators. The most popular Thermo Fisher design is the Heracell VIOS 160i
CO2 Incubator with Copper Interior Chambers, which has HEPA filtration for
ISO Class 5 air quality and an overnight Steri-Run for total sterilization [5].
Others have also attempted to design low-cost live-cell imaging platforms using
3D printed and off the shelf components. Both okolabs and Elliot Scientific have
stage-top microscopic incubators available, both of which use the direct heat
method, and have had great success in maintaining a homogeneous environment
in terms of temperature and CO2 percentage[6,7]. However, these stage top
incubators are still extremely expensive ranging from $431-$1000 and are only
compatible with XY stage inserts[8]. XY stage inserts are roughly
150x150x36mm[9], slightly smaller dimensions than the stage top the team is
currently working on. A team of researchers from Australia were able to
successfully design a portable low-cost long-term live-cell imaging platform for
biomedical research and education for under $1750 [10]. This low-cost incubator
also monitored and regulated temperature, CO2, and humidity as per the
parameters for successful mammalian cell culture. A company called ibidi has
developed a stage top incubator compatible with an inverting microscope
following all of the temperature, humidity, and CO2 requirements as well as
producing anti-condensation glass technology. The incubator is currently on the
market for $19,000 [11]. Past BME 200/300 design projects have attempted to
build incubators for this client, but none have been completely successful.
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Appendix B: Incubator Fall 2022

Figure 1: Incubator Prototype Exterior Figure 2: Incubator Prototype Interior



Figure 3: Whole incubator setup

Figure 4: Exploded SOLIDWORKS assembly of the final design along with a table explaining the
dimensions and parts





Figure 5: Laser Cut designs and dimensions



Appendix C: Testing Protocols
Internal Environment - Temperature and Humidity Sensor Test Protocol

Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team will be employing a sensor inside the incubator in order to measure the internal

temperature. The measurements of the humidity and temperature will be obtained by an
AOSONG DHT22 Arduino compatible sensor. The team will test to make sure that the code and
the AOSONG are working correctly by calibrating the sensor and then confirming its accuracy at
steady state and precision in a dynamic range using a thermometer. To calibrate the sensor, the
team will use resistance values on the Arduino Website. Once the sensor is calibrated, its
accuracy will be tested by first measuring the temperature and humidity of the working
environment to gauge if they are both working as expected, and then measuring its temperature
at extreme high and low temperatures. Afterwards, the team will measure the temperature inside
the incubator with a thermometer and the sensor. To keep the incubator completely sealed, the
thermometer probe and reading display will be inserted into the incubator and read through the
glass. The tests will be considered successful if the sensor value is within 2℃ of the thermometer
temperature.

Steps Protocol Verification Pass/Fail Initials
of Tester

1 Calibrate the sensor using
resistance values on Arduino
Website.

Verified
Comments:

2 Test the precision of the Arduino
microcontroller at extreme high
and low temperatures. Heat a cup
of water in a microwave for two
minutes. Place the sensor in the cup
of hot water and ensure the
temperature outputs increase the
longer it is under heat. Then, place
the sensor in the freezer and ensure
the temperature outputs decrease
the longer it is under there. If the
sensor follows these trends, it is
verified.

Verified
Comments:



3 Set up the incubator for normal use.
Set up a digital thermometer within
the system.

Verified
Comments:

4 Set up the Arduino sensor and
incorporate the breadboard circuits.

Verified
Comments:

5 Record the average temperature of
the system from the thermometer in
the comments, taking
measurements every 10 seconds
over a period of 10 minutes. Verify
that this temperature falls within
the optimal range of 37℃ ± 2℃.

**If the thermometer does not
seem calibrated correctly, try first
measuring the temperature of room
temperature water (approximately
25℃).

Verified
Comments:

6 Record the average temperature of
the system from the Arduino
microcontroller in the comments,
taking measurements every 10
seconds over a period of 10
minutes. Verify that this
temperature falls within ± 2℃ of
the temperature read by the
thermometer.

Verified
Comments:

7 Record the average humidity
percentage from the Arduino
microcontroller in the comments,
taking measurements every 10
seconds over a period of 10
minutes, and verify that this value
falls between 95-100%.

Verified
Comments:



Internal Environment - CO₂ Sensor & Feedback System Test Protocol

Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team will be employing sensors inside the incubator in order to measure the internal

CO₂. For CO₂, the tank employed in the current lab has a sensor to check the CO₂ levels, but a
CO₂ sensor will be placed inside the incubator as well. The measurement of CO₂ recorded by the
Arduino sensors should be within 2% of the pressure gauge on the CO₂ tank.

Steps Protocol Verification Pass/Fail Initials
of Tester

1 Test the precision of the sensor by
ensuring its values increase and
decrease with general increase and
decrease of CO₂ concentration.
Place the sensor in front of the CO₂
tank dispenser tube. Allow gas to
exit the tank at a low flow rate.
Ensure the sensor value readings
increase as the sensor exposure to
CO₂ gas increases. If this occurs,
this step is verified.

Verified
Comments:

2 Similarly, once the CO₂ supply
from the tank is turned off, ensure
the value readings from the sensor
decrease. If this occurs, this step is
verified.

Verified
Comments:

3 Set up the incubator for normal use.
Record the value read by the fyrite
at room conditions in the
comments.

Verified
Comments:

4 Set up the CO₂ sensor and fyrite
within the incubator and seal it.
Allow enough CO₂ to enter the
incubator that the fyrite reads
around 5% CO₂. Record the value

Verified
Comments:



given by the fyrite, the value given
by the CO₂ sensor, and the trial
number in the comments.

5 Remove the incubator from under
the microscope and allow the CO₂
to leave the system so that its value
read by the fyrite is nearly the same
as room conditions. Repeat steps
5-4 until 5 trials are complete.
Record the mean value of
difference between the read CO₂
values in the comments.

Verified
Comments:

6 If the CO₂ sensor deviates from the
actual CO₂ percentage by ±0.1% or
less, then the sensor is verified for
use. If not verified, record why in
the comments.

Verified
Comments:

Steps Protocol Verification Pass/Fail Initials
of Tester

1 Once the CO₂ sensor is approved
for use, set up the incubator for
normal use with the CO₂ sensor
inside. Seal the incubator.

Verified
Comments:

2 Connect the CO₂ tank to the
incubator fixed with a regulator and
a solenoid.

Verified
Comments:

3 Verify the sensor is recording
values. Then, begin running
feedback code in conjunction with
the solenoid connected to the CO₂
tank.

Verified
Comments:

4 The solenoid should let CO₂ into
the system immediately. Once the
CO₂ sensor reads a value within 5%
±0.1% CO₂ the solenoid should
stop allowing CO₂ into the
incubator. If this occurs, continue
protocol and step is verified. If this

Verified
Comments:



does not occur, stop protocol and
record what happened in the
comments.

5 Allow the feedback loop to run for
an hour. Record the sensor values
read into a graph. Verify that over
the hour the CO₂ percentage
remained near a level of 5% CO₂
±0.1%. If the CO₂ remained in this
range, continue protocol and step is
verified. If this did not occur, stop
protocol and record what happened
in the comments.

Verified
Comments:

6 Repeat step 5 over the course of 6
hours. If the CO₂ remains in the
necessary range, continue the
protocol and this step is verified. If
this did not occur, stop protocol and
record what happened in the
comments.

Verified
Comments:



Recovery Test Protocol

Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team will test the recovery time of the incubator after it has been opened by timing

how long it takes for the incubator to return to performance conditions (37°C, 5% CO₂, and
>95% humidity). The maximum recovery time should not exceed five minutes after a 30 second
exposure to the external environment.

Steps Protocol Verification Pass/Fail Tester
Initials

1 Set up the incubator for normal
use. Record internal conditions
in the comments and verify that
they fall within the correct
ranges (37°C, 5% CO₂, and
>95% humidity).

Verified
Comments:

2 Open the incubator for 30
seconds. Start stopwatch. Verify
that the stopwatch is working.

Verified
Comments:

3 Record internal conditions in the
comments at a time of 15
seconds after opening the
incubator. Verify that the
internal conditions deviate from
the normal conditions recorded
above.

Verified
Comments:

4 Close the incubator.
Verify that the recovery time did
not exceed 5 minutes after a 30
second exposure to the external
environment. Record the time it
took to revert back to optimal
conditions in the comments.

Verified
Comments:



Homogeneity Test Protocol

Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team will test the homogeneity of each of the internal conditions throughout the

system to ensure that performance conditions are met in a uniform manner. The goal is for each
of the conditions to maintain their homeostatic values throughout the incubator: 37°C, 5% CO2,
and >95% humidity.

Steps Protocol Verification Pass/Fail Tester
Initials

1 Obtain a lid with the same
dimensions as the top of the
incubator and ensure that there
are holes throughout the frame
of the lid.

Verified
Comments:

2 Place probes/sensors for
temperature into each hole and
record its value.

Verified
Comments:

3 Calculate and report the
precision result (mean ∓ average
deviation). Verify that all of the
values for temperature fall
within this precise range
(ensures uniformity).

Verified
Comments:

4 Repeat steps 1-3 for the
humidity component.

Verified
Comments:

5 Repeat steps 1-3 for the CO2
component.

Verified
Comments:



Sanitation Protocol

Introduction
Name of tester:
Dates of test performance:
Site of test performance:

Explanation:
This team will be utilizing the prototype to house live cells and therefore needs to follow

biosafety level 1 standards. This requires that incubators be sterile in order to reduce
contamination and unwanted bacteria growth. Before use the prototype will be placed inside one
of the biosafety cabinets in the teaching lab with the inside of the box and lid facing upwards.
With a closed sash, the team will turn on the UV light and allow for the box to be sanitized for
15 min. Once complete, the prototype will be removed from the cabinet, sprayed with 70%
ethanol, and wiped dry with a kemi wipe. The water bath will consist of DI water in order to
further reduce possible contaminants. These steps should be repeated before each use.

Steps Protocol Verification Pass/Fail Initials of
tester

1 Raise the sash of the
biosafety cabinet and
place the prototype
inside. Ensure the bottom
half has the water bath
facing the light and the
inside of the lid is also
facing the light.

Verified
Comments:

2 Close the sash and turn
on the UV light. Leave
for 15 minutes.

Verified
Comments:

3 Open the sash and
remove the prototype.

Verified
Comments:

4 Spray the entire inside
and outside of the
prototype with 70%
ethanol. Wipe completely
dry with a Kemi wipe.

Verified
Comments:

5 Assemble the prototype Verified



on the microscope stage,
hooking up the water
tank, CO2 tank, and
sensors.

Comments:

6 Fill the water bath inside
the prototype with DI
water. Close the lid.

Verified
Comments:



Cell Confluency Test Protocol
Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team employed image J to quantify the percentage of area covered by the cells over

time in order to quantify the cell proliferation. This allowed the team to compare cell
proliferation in the standard incubator compared to the prototype. The images of the cells were
taken using the Zeiss scope in the teaching lab. The control was a T25 flask that was cultured in
the standard incubator to provide a baseline on appropriate cell death over the course of a week.
Another T25 flask was cultured inside the prototype over the course of a week. Using the Zeiss
scope, an image was taken every 24 hours, and those images were loaded into image J. The team
was able to quantify the percent of cell coverage and track cell confluency over the course of the
week. Tests will be considered successful if there is no significant difference between the
confluency between the control and the prototype.

Steps Protocol Verification Pass/Fail Initials
of Tester

1 Day 0: Using the cell flask from the
control incubator, change the cell
media, and image a section.
Analyze image in ImageJ to
determine percent area coverage.
Return flask to the control
incubator after each imaging.

Verified
Comments:

2 Day 1-6: Repeat step 1 every 24
hours for 6 days for the flask in the
control incubator.

Verified
Comments:

3 Day 0: Using the cell flask from the
prototype incubator, change the cell
media, and image a section.
Analyze image in ImageJ to
determine percent area coverage.
Return flask to the prototype
incubator after each imaging

Verified
Comments:

4 Day 1-6: Repeat step 1 every 24
hours for 6 days for the flask in the
prototype incubator.

Verified
Comments:



5 Plot both the control and the test
percent area coverage vs time to
determine if they are statistically
similar.

Verified
Comments:



ImageJ Percent Area Coverage Procedure

Introduction
Name of Tester:
Dates of Test Performance:
Site of Test Performance:

Explanation:
The team will be using ImageJ to analyze the images taken of the cells using the Zeiss

microscope. ImageJ will calculate the percentage of surface area covered by the cells and from
this, a trend line can be made that tracks the cell proliferation over the course of 5 days.

Procedure:
1. Take images of the cells, ideally in the same spot each time
2. Open ImageJ and open the file you just created (file type does not matter)
3. Image → Type → 8-bit; this will turn the image into an 8-bit greyscale
4. Process → Subtract Background; this will remove the background of the image making

the cells more visible
a. Adjust the rolling ball radius until the optimal contrast between the background

and cells is achieved (somewhere between 60-150 pixels)
5. Process → Filters → Median; this will reduce noise and sharpen cell selection (a radius

between 2 and 5 is usually acceptable)
6. Image → Adjust → Threshold; this will select only the cells

a. Move the bottom line all the way to the right and adjust the top line until only the
cells are white

7. Analyze → Set Measurements → Check Area Fraction; this will calculate the percentage
area coverage of a selected image

8. Using the mouse to select the entire image, creating an ROI
9. Analyze → Tool → ROI Manager → Add → Click coordinates → Measure; this will

provide you with an output box that has the percent area coverage calculated



Optical Image Analysis Protocol
1. Open ImageJ
2. Insert desired image

a. Convert type to 16-bit if it is not already
3. Perform Microscope Image Focus Quality plugin

a. Don’t generate probability image, only do overlay (with border width = 5)
4. Save image as .jpg
5. Edit > Copy to system
6. Put the image into Paint
7. On ImageJ, do Files > New Image (type is RGB)

a. Check pixels and put in the right numbers (3584 x 2746)
8. Copy image from Paint into ImageJ
9. Image > Color > Split Channels
10. Do Analyze > Measure on all 3 images created (blue, green, and red)
11. Record means into spreadsheet - indicate focus quality

**Red = in focus
**Green = middle focus
**Blue = out of focus

Fan Testing Protocol
1. Open ImageJ
2. Insert desired image

a. Convert type if needed
3. Create a freehand selection around the well plate area of the incubator
4. Measure the area - this will be normalized to 100%
5. Create another freehand selection encompassing the area that is foggy - do this for all

foggy sections
6. Measure the area - these added up will be the foggy areas
7. Calculate the percentage of foggy areas (foggy area / total area)
8. Compare the foggy regions in each of the experimental cases (with each of the varying

fan placements)
9. Calculate statistical significance via a chi-squared test - aiming for no statistical

significance from the control



Appendix D: Circuitry & Code
D1. Circuitry

Figure 1: Circuitry

D2. CO2 Accuracy Code
#include <SoftwareSerial.h>
#include <NDIR_SoftwareSerial.h>

//Select 2 digital pins as SoftwareSerial's Rx and Tx. For example, Rx=2 Tx=3
NDIR_SoftwareSerial mySensor(2, 3);

void setup()
{
Serial.begin(9600);

if (mySensor.begin()) {
Serial.println("Wait 10 seconds for sensor initialization...");
delay(10000);

} else {



Serial.println("ERROR: Failed to connect to the sensor.");
while(1);

}
}

void loop() {
if (mySensor.measure()) {
Serial.print("CO2 Concentration is ");
Serial.print(mySensor.ppm);
Serial.println("ppm");

} else {
Serial.println("Sensor communication error.");

}

delay(1000);
}

D3. CO2 Feedback loop Code
#include <SoftwareSerial.h>
#include <NDIR_SoftwareSerial.h>

//Select 2 digital pins as SoftwareSerial's Rx and Tx. For example, Rx=2 Tx=3
NDIR_SoftwareSerial mySensor(2, 3);
int relayPin = 13;
float x;

void setup()
{
Serial.begin(9600);
pinMode(relayPin, OUTPUT);

if (mySensor.begin()) {
Serial.println("Wait 10 seconds for sensor initialization...");
delay(10000);

} else {
Serial.println("ERROR: Failed to connect to the sensor.");
while(1);

}
}
//concentration
if (mySensor.measure()) {
Serial.println();

} else {
Serial.println("Sensor communication error.");



}
x = (mySensor.ppm*5.0)/10000;
if( x <= 4.5){
digitalWrite(relayPin, HIGH); //switch relay on
delay(50); //short input of CO2
digitalWrite(relayPin, LOW);
delay(5000);
}else{
digitalWrite(relayPin, LOW); //switch relay off
}

Serial.println(x);
delay(600000);

D4. Internal Environment Code
#include <SoftwareSerial.h>
#include <NDIR_SoftwareSerial.h>

//Select 2 digital pins as SoftwareSerial's Rx and Tx. For example, Rx=2 Tx=3
NDIR_SoftwareSerial mySensor(2, 3);
int relayPin = 13;
float x;
//temp
int ThermistorPin = 0;
int Vo;
float R1 = 10000;
float logR2, R2, T;
float c1 = 1.009249522e-03, c2 = 2.378405444e-04, c3 = 2.019202697e-07;
float Tc;
float e_s;
float e_d;
float Td = 36.1;
void setup()
{
Serial.begin(9600);
pinMode(relayPin, OUTPUT);

if (mySensor.begin()) {
Serial.println("Wait 10 seconds for sensor initialization...");
delay(10000);

} else {
Serial.println("ERROR: Failed to connect to the sensor.");



while(1);
}

}

void loop() {
//concentration
if (mySensor.measure()) {
Serial.println();

} else {
Serial.println("Sensor communication error.");
digitalWrite(relayPin, HIGH); //switch relay on
delay(50); //short input of CO2
digitalWrite(relayPin, LOW);
delay(5000);

}
x = (mySensor.ppm*5.0)/10000;
if( x <= 4.5){
digitalWrite(relayPin, HIGH); //switch relay on
delay(50); //short input of CO2
digitalWrite(relayPin, LOW);
delay(5000);
}else{
digitalWrite(relayPin, LOW); //switch relay off
}
//temp
// read the value from the sensor:
Vo = analogRead(ThermistorPin);
R2 = R1 * (1023.0 / (float)Vo - 1.0);
logR2 = log(R2);
T = (1.0 / (c1 + c2*logR2 + c3*logR2*logR2*logR2));
Tc = T - 273.15;
//hum
float hum =0;
e_s = 6.11 * pow(10, ((7.5 * Tc)/(237.7 + Tc)));
e_d = 6.11 * pow(10, ((7.5 * Td)/(237.7 + Td)));
hum = ((e_d/e_s)*16)-4;

//Printing
Serial.println(Tc);
Serial.println(x);



Serial.println(hum);
delay(600000);

}

D5. Display Code
/* Serial 7-Segment Display Example Code
SPI Mode Stopwatch
by: Jim Lindblom
SparkFun Electronics
date: November 27, 2012
license: This code is public domain.

This example code shows how you could use the Arduino SPI
library to interface with a Serial 7-Segment Display.

There are example functions for setting the display's
brightness, decimals and clearing the display.

The SPI.transfer() function is used to send a byte of the
SPI wires. Notice that each SPI transfer(s) is prefaced by
writing the SS pin LOW and closed by writing it HIGH.

Each of the custom functions handle the ssPin writes as well
as the SPI.transfer()'s.

There's a custom function used to send a sequence of bytes
over SPI - s7sSendStringSPI, which can be used somewhat like
the serial print statements.

Circuit:
Arduino -------------- Serial 7-Segment
5V -------------------- VCC
GND -------------------- GND
8 -------------------- SS
11 -------------------- SDI
13 -------------------- SCK

*/
#include <SPI.h> // Include the Arduino SPI library

// Define the SS pin
// This is the only pin we can move around to any available



// digital pin.
const int ssPin = 8;

unsigned int counter = 0; // This variable will count up to 65k
char tempString[10]; // Will be used with sprintf to create strings

//temp
int sensorPin = A0; // select the input pin for the potentiometer
int ledPin = 13; // select the pin for the LED
int sensorValue = 0; // variable to store the value coming from the sensor
float volt_conversion = 5.0/1023.0;
float ADC_voltage = 0;
float K_temperature = 0;
float C_temp;
void setup()
{
// -------- SPI initialization
pinMode(ssPin, OUTPUT); // Set the SS pin as an output
digitalWrite(ssPin, HIGH); // Set the SS pin HIGH
SPI.begin(); // Begin SPI hardware
SPI.setClockDivider(SPI_CLOCK_DIV64); // Slow down SPI clock
// --------

// Clear the display, and then turn on all segments and decimals
clearDisplaySPI(); // Clears display, resets cursor

// Custom function to send four bytes via SPI
// The SPI.transfer function only allows sending of a single
// byte at a time.
s7sSendStringSPI("DEGC");
setDecimalsSPI(0b11111); // Turn on all decimals, colon, apos

// Flash brightness values at the beginning
setBrightnessSPI(0); // Lowest brightness
delay(1500);
setBrightnessSPI(255); // High brightness
delay(1500);

// Clear the display before jumping into loop
clearDisplaySPI();



}

void loop()
{

// Magical sprintf creates a string for us to send to the s7s.
// The %4d option creates a 4-digit integer.
// read the value from the sensor:
sensorValue = analogRead(sensorPin);
ADC_voltage = sensorValue * (volt_conversion);
K_temperature = (ADC_voltage - 0.205) / 0.0153;
C_temp = K_temperature - 91;
counter = C_temp*100;
sprintf(tempString, "%4d", counter);
// This will output the tempString to the S7S
s7sSendStringSPI(tempString);

// Print the decimal at the proper spot
if (counter < 10000)
setDecimalsSPI(0b00000010); // Sets digit 3 decimal on
else
setDecimalsSPI(0b00000100);

counter++; // Increment the counter
delay(1000); // This will make the display update at 100Hz.*/
}

// This custom function works somewhat like a serial.print.
// You can send it an array of chars (string) and it'll print
// the first 4 characters in the array.
void s7sSendStringSPI(String toSend)
{
digitalWrite(ssPin, LOW);
for (int i=0; i<4; i++)
{
SPI.transfer(toSend[i]);
}
digitalWrite(ssPin, HIGH);
}



// Send the clear display command (0x76)
// This will clear the display and reset the cursor
void clearDisplaySPI()
{
digitalWrite(ssPin, LOW);
SPI.transfer(0x76); // Clear display command
digitalWrite(ssPin, HIGH);
}

// Set the displays brightness. Should receive byte with the value
// to set the brightness to
// dimmest------------->brightest
// 0--------127--------255
void setBrightnessSPI(byte value)
{
digitalWrite(ssPin, LOW);
SPI.transfer(0x7A); // Set brightness command byte
SPI.transfer(value); // brightness data byte
digitalWrite(ssPin, HIGH);
}

// Turn on any, none, or all of the decimals.
// The six lowest bits in the decimals parameter sets a decimal
// (or colon, or apostrophe) on or off. A 1 indicates on, 0 off.
// [MSB] (X)(X)(Apos)(Colon)(Digit 4)(Digit 3)(Digit2)(Digit1)
void setDecimalsSPI(byte decimals)
{
digitalWrite(ssPin, LOW);
SPI.transfer(0x77);
SPI.transfer(decimals);
digitalWrite(ssPin, HIGH);
}



Appendix E: Materials Purchasing
Table 1: Materials Purchasing Table

Expenses
Item Description Manufacturer Part Number Date QTY Cost

Each
Total Link

Component 1

MH-Z16 NDIR CO2 Sensor Sandbox
Electronics SEN-000030 2/7 1 $67.59 $67.59 Link

Component 2

RKI
Waterproof
Sensor Cover

CO2 Waterproof
Sleeve RKI 33-0172RK 2/7 1 $5.37 $5.37 Link

Component 3

Coolerguys
25mm USB
Fan

Miniature fans to
decrease
condensation on
glass

Amazon
840556070320 2/16 2 $6.99 $13.98 Link

TOTAL: $86.94

https://sandboxelectronics.com/?product=mh-z16-ndir-co2-sensor-with-i2cuart-5v3-3v-interface-for-arduinoraspeberry-pi
https://www.globaltestsupply.com/product/rki-33-0172rk-waterproof-sensor-cover
https://www.amazon.com/Coolerguys-25mm-25x25x10-USB-Fan/dp/B07NC4Z24T/ref=sr_1_4?crid=2B9YKXEWEQCTU&keywords=mini+fan+25+mm+usb&qid=1676510571&sprefix=mini+fan+25+mm+usb%2Caps%2C138&sr=8-4

